
Contents
Welcome to TapeMaker!

What is TapeMaker?

Registering TapeMaker

Getting the Latest Version

Distributing TapeMaker

Technical Support

How do I...
Create a new music database?
Add and edit albums?
Read information from a CD?
Delete albums?
View my database?
Search through my database?
Customize the database with my own data fields?
Make a cassette insert?
Play a CD?
Register this marvelous program?

Please explain...
The Main Window.
The Database Fields window.
The Cassette Insert window.
The Background Picture window.
The CD Player window.
The Registration window.
The nag screen.



What is TapeMaker?
TapeMaker is a sophisticated combination of a music database and a cassette insert printer. 
Whether you want to keep track of your music collection or print beautiful cassette inserts or 
both, TapeMaker is for you. You'll find features here that simply aren't available anywhere else.

TapeMaker's database features let you view all the albums, artists or songs in your collection. 
When you select an album, artist, or song from the left half of the window, the album's details 
instantly appear on the right giving you quick access to information. The database is even 
customizable, so you can add data fields with any information you want in them. With 
TapeMaker, you're not limited to what the program thinks is important information.

If you like making tapes from your music collection for use in your car or at parties, TapeMaker 
lets you make the most of your cassette. You can drag and drop music from the database to the 
cassette insert, tell TapeMaker to find the best arrangement of music to fill up your cassette, 
choose fonts and background patterns for the cassette insert, and print it out.

TapeMaker also comes with a built-in CD player.

TapeMaker comes with a sample database, SAMPLE.MUS, so that you can load it and quickly 
explore how TapeMaker works. Keep an eye on the status bar at the bottom of the window. It 
displays hints on how to use the program. And remember, you can hit F1 at any time to get help.



Creating a new music database

Select File | New from the main window's menu or click the  button on the main window's 
toolbar. If you already have a database open, and you have made changes to the database, 
TapeMaker will ask if you are sure you want to lose your changes.

See also:

Adding and Editing Albums



Adding and editing albums
To add a new album to your database, select Album | New Album from the main window's menu 
or click the  button on the main window's toolbar or type Ctrl+N.

To edit an album, select it, then select Album | Edit Album from the main window's menu or click 
the  button on the main window's toolbar or type Ctrl+E.

In either case, the album details will become editable.

NOTE: You can not edit an album that has songs on the cassette insert. If you try, 
TapeMaker will warn you and ask if you would like to remove the songs from the cassette 
insert. You can choose to remove them and proceed with the editing, or cancel the editing.

Once you've clicked New or Edit, you can fill in all the album detail fields. Every album must 
have a title, unless it is a 45 RPM record (you remember those, right?) or a 3" CD. Every album 
must also have at least one song. Each song must have an artist, either in the Artist field next to
the album title or in the Artist field next to the song title. If you forget anything, TapeMaker will 
remind you.

Most albums have only one artist. For these, enter the artist's name in the Artist field next to the 
album title. But many albums have a collection of songs from different artists. For these, enter 
the artist name for each song next to the song title in the song grid.

To insert a song in the middle of an album, select a song, then click the  button or the 
Album | Insert Song menu item or type Ctrl+Ins. The song you selected, and all following songs, 
will be moved down and a blank line will be added where you can enter the song information. To
delete a song, select it and click the Album | Delete Song menu item or type Ctrl+Del.

When you finished editing, click the  button or the Album | Save Changes menu item or 
type Ctrl+S. If you don't want to save your changes, click the  button or the Album | Cancel 
Editing menu item or type Ctrl+L.

Reading Song Times from a CD

Deleting Albums



Viewing the Database

On the left of the main window is a list of all the albums in your database in alphabetical order. 
Above that is three tabs labeled Albums, Artists, and Songs. You can click on those tabs to view 
the artists or songs in your database, also in alphabetical order:

In the Song list, both the title and the playing time for each song is displayed. If you have not 
entered a song time, TapeMaker will display "??:??" instead.

When you highlight an album in the album list, its details appear on the right. When you 
highlight a song in the song list, its album's details appear on the right:

But what happens if you highlight an artist in the artist list and there's more than one album by 
that artist? In that case, a list box appears in the lower left with all the albums by that artist:



TapeMaker's purpose in life is to make tapes. There may be times when you have a little space 
left on a tape and you want to find a song that is just the right size to fill it. You can display all 
the songs in your database in order of their playing times by selecting the Songs tab, positioning
the mouse over the songs, clicking the right mouse button, and selecting Sort by Time from the 
pop-up menu. To switch back, select Sort Alphabetically from the pop-up menu.



Customizing the Database
You display the cassette insert window by selecting Tools | Database Configuration from the 
main window's menu.

Every album has some standard fields defined: album title, artist name, and media. But you 
might want to add some of your own. Perhaps you want to keep track of when the album was 
made, or the type of music it is. The Database Fields window lets you create these fields. You 
can get this window by choosing Tools | Database Configuration from the main menu.

There are four quadrants in this window. Each quadrant holds the information for a user defined 
field. The top two quadrants are used to define text fields, which can hold anything you care to 
type. The bottom two are for multiple choice fields.

A field needs to be enabled for it to appear on the album details of the main window. You may 
not want all four user defined fields, so you can turn any of them off by unchecking its Enabled 
box. If you want to use the field, check Enabled.    In the above example, one multiple choice 
field and one text field are being used. 

Next, every field that is used must have a field name. This can be any text you choose. Note 
that in the above figure, the field names have an ampersand (&) in them. When the field is 
displayed in the album details, the character following the ampersand will be underlined and you
can quickly go to that field by holding down the Alt key and typing that character.

The multiple choice fields need a list of choices that will appear in a drop-down list in the album 
details of the main window. The first item in the list of choices is special. Whenever you enter 
new album information, the multiple choice field for that album will automatically be set to the 
first item.    Obviously, you are able to change it as you enter the data. But you will find it most 
convenient if the most common item is listed first. In this example, the user buys mostly Rock 
and Roll music, so he listed it first.

Also, when you define a multiple choice field for the first time, all the albums already entered in 
your database will be set to the first item.

A Warning About Changing Database Fields



Reading Song Times from a CD

When you are entering album information into your database, you can read song times from a 
CD if you have a CD-ROM drive. (Unfortunately, album titles, song titles, and artist names are 
not stored on audio CDs.) If TapeMaker detects that you have a CD-ROM drive and a CD is in 
the drive, the  button and the Album | Read Times From CD menu item will be enabled. 
Select either of these or type Ctrl+R to fill in the song times in the album details.

If you have a CD-ROM drive and TapeMaker is not enabling the button and menu item, you 
might not have the multimedia audio CD driver installed. Install it via Windows' Control Panel.

Adding and Editing Albums



The Cassette Insert Window
You display the cassette insert window by selecting Tools | Cassette Insert from the main 
window's menu or clicking  on the main window's toolbar.

Click on parts of the window to see what they do:

Adding music to a cassette
Removing music from the cassette
Optimizing and randomizing the music
Manually rearranging the music
The edge flaps
Changing fonts
Adding a background picture
Printing out the cassette insert
Printing out the song list.

The Insert Menu:
Optimize
Randomize
Clear
Print Setup...
Print Insert...
Print Song List...
Close

The Layout Menu:
1. Flaps on Top, Songs Side-by-Side
2. Flaps on Bottom, Songs Side-by-Side
3. Flaps on Top, Sides Stacked Vertically
4. Flaps on Bottom, Sides Stacked Vertically
Select Background Picture...



How do I play a CD?



The Main Window
The main TapeMaker window allows you to view your database of albums, add and edit albums,
search the database, and to display all the other windows in TapeMaker (the cassette insert, the
database configuration, the CD player, and the registration window).

When you start TapeMaker, it remembers the last size and position of its windows. It also 
remembers the last database you had loaded and automatically re-loads it.

The buttons on the toolbar allow you to quickly access common features. When you place the 
mouse cursor over a button, a yellow hint will appear next to the cursor and a longer description 
of the button will appear in the status bar at the bottom of the window.

Click on parts of the toolbar to see what they do:

The File Menu:

New
Open
Merge
Save
Save As...
Export...
Exit

The Album Menu:

New Album
Edit Album
Delete Album
Read Times from CD
Insert Song
Delete Song
Save Changes
Cancel Editing

The Tools Menu:

Cassette Insert
CD Player
Find...
Find Again



Database Configuration
Register TapeMaker...



Attempts to arrange the songs on the cassette such that the cassette is completely filled with 
music, with no unused tape on either side. It is most likely to succeed if you have selected 
several more minutes of music than will fit on the cassette.



Skip forward 10 seconds.



The CD Player
You display the CD player window by selecting Tools | CD Player from the main window's menu 
or clicking  on the main window's toolbar.

Click on parts of the window to see what they do:

The CD Player controls are straightforward if you've ever used a real CD player. The POWER 
button closes the window (but, if you're playing a CD, it will continue to play). The buttons to the 
side of the digital display are enabled when you're playing a CD and jump forward or backward 
by 10 seconds on the CD.



The Registration Window
I hope you will decide to register TapeMaker. A lot of work over many years went into 
TapeMaker, and I've been very attentive to my customers in fixing bugs they find (and giving 
them free updates), adding features, and helping them with any difficulties they ran in to.

You can display the registration window by selecting Tools | Register TapeMaker from the main 
window's menu.

Just fill in your name and address, select the floppy disk size you want, tell me where you found 
TapeMaker (it helps me to know how far it's spread) and give me any suggestions you have. 
Then click the Print button and follow the mailing instructions on the print out.

If you're overseas, don't worry about the postage. I realize it's inconvenient for you to get U.S. 
currency or checks, so the least I can do is pay the extra postage myself.

When you register, you will get the latest copy of TapeMaker for Windows, a printed manual, 
and a registration ID that you can use to disable the nag screen that appears when you exit 
TapeMaker.



The Nag Screen
TapeMaker is shareware. If you use it for most than 30 days, you should register it. The "nag 
screen" appears when you exit TapeMaker as a friendly reminder. When you register, you will 
get the latest version of TapeMaker, a printed manual, and an ID number that you can enter into 
the nag screen and stop it from ever appearing again.

Registering TapeMaker



Optimizing the songs on your cassette



Lets you choose a background image to print on the cassette insert. The image will not appear 
in the cassette insert window, but will appear on your print-out. Also see the Background Picture
window.



Deleting albums
To delete an album from your database, select it on the left side on the main window and select 
the Album | Delete Album menu item.



Searching Through the Database
You can search for text in your database by selecting Tools | Find... from the main window's 
menu or typing Ctrl+F. A standard search dialog will appear. The search will be done through 
albums, artists, or songs depending on which is being displayed on the left. You can repeat a 
search by selecting Tools | Find Again or typing F3.

Viewing the Database



A Warning About Changing Database Fields

You can define a field and change its definition at some later time, but you need to understand 
what will happen if you do.

u If you disable a field, you will lose all of the information you have entered in that field for 
each album. 

u If you change the name of a field, you will not change any of the information stored in 
that field.

u If you change the items in a Multiple Choice field, you may get strange results. When 
you enter album information, TapeMaker stores the multiple choice field value as a 
number, 1 through 10, indicating which item you chose. If you then change the text of the
item, the number TapeMaker has saved will not change, but the text you have 
associated with the number will. For example, if "Rock" were changed to "Muzak" in 
figure 8, all your rock and roll albums would change to Muzak.    This is not only 
undesirable, it is nightmarish.    It is safest to add any new items to the end of the 
multiple choice list, where it will not affect any data that has already been entered.



Adding music to a cassette
To add songs to the cassette insert, drag them from the main window and drop them on 
the cassette insert. You can drag albums (in which case all songs on the album are 
added), artists (in which case all songs by the artist are added) or individual songs. You 
can drag any of these from the left side of the main window or you can drag songs or 
the album title from the album details side.

Most screens are too small to show the main window and the cassette insert window 
side by side, so it's difficult to drag from one window to another. So instead, you can 
drag music to the cassette insert button ( ) on the main window's toolbar.

TapeMaker uses the playing time of songs to determine how many will fit on a tape. So 
you can not drag a song to the cassette insert if it has no time entered.



Saves your picture selections and closes the dialog.



Optimizing and randomizing the music

If you would like to mix up the songs you have selected, click  or select the Insert | 
Randomize menu item. This is useful if, for example, you have selected all the songs from a few 
albums. If you kept the songs in the order you selected them, you would end up with 45 minutes
of one artist, 30 minutes of the next artist, and 40 minutes of the third artist.    You may prefer to 
shuffle the songs so that you have more variety.

If you would like to optimize the order of the songs, click  or select the Insert | Optimize menu 
item. TapeMaker will attempt to re-order the songs so that there is no blank tape left. There is 
usually more than one "best" order for the songs. If you do not like the order that TapeMaker 
came up with, you can randomize the songs, then re-optimize them.

It is not always possible to find a perfect order for the songs, i.e., an order where there is no 
blank tape left on either side.    However, you can improve the odds by selecting more music 
than can fit on the tape. For example, if you select 110 minutes of music for a 90 minute tape, 
TapeMaker will probably find some arrangement of songs that will fill exactly 45 minutes on 
each side.    Of course, 20 minutes of the music you selected will be left off the tape.



Manually Rearranging the Music
You can manually rearrange the songs on your cassette insert. Typically, you may want to rely 
on TapeMaker's randomize and optimize features. But sometimes they will arrange songs such 
that two songs that you don't want next to each other, are next to each other.

You can drag and drop songs between the three list boxes (the Side A and Side B list boxes and
the Excess Songs list box). You can also drag songs from one place in a list box to another. 
However, keep in mind that TapeMaker is always making sure that the music fits on the tape. If 
you move a song from Side B to Side A, TapeMaker will probably have to move the last song 
from Side A over to Side B.



Position the mouse over the section whose font you want to change (either Side A, Side B, or 
one of the edge flaps) and click the right button. A menu will pop-up with a Font... item. Select 
the item to get to the standard Windows font dialog.



The Background Picture Window
You can decorate the background of your cassette insert with a background picture. You should 
be careful in choosing your pictures; a dark picture will obscure the text on your print-out.

You display the Background Picture dialog by selecting Layout | Select Background Picture... 
from the cassette insert window's menu, clicking  on the toolbar or typing Ctrl+B.

Click on parts of the window to see what they do:

A drop-down list box at the bottom of the dialog lets you select a built-in background picture of a 
musical staff, or no background at all. The Open... button displays a standard file dialog box that 
lets you choose your own picture (Windows bitmaps only) to use as a background.

You can choose to have the picture tiled, centered, or stretched to fill the cassette insert 
background by selecting the respective radio button. A cassette insert's flap is 4" wide and 2.6" 
high. If you stretch a picture whose ratio of width to height is not 4:2.6, the picture will be 
distorted. If you center the picture, the picture will be magnified by integer amounts (e.g. it will 
be doubled or tripled in size, but not magnified by 2.5) to fill as much of the flap as possible, but 
without distorting it. 

The background will not appear in the cassette insert window, but it will appear on your print-
out. TapeMaker will remember your background selections the next time it is run.



Printing the Cassette Insert
Select Insert | Print Insert... from the Cassette Insert window's menu or click  on the toolbar.

See Also
Printing the song list



Shuffles the songs on the cassette.



Print the cassette Insert. See also Printing the song list.



Changes the layout of the cassette insert. You can have Side A and Side B side-by-side or 
stacked one on top of the other. You can have the edge flaps at the top or the bottom.



Specifies the length of the cassette tape. TapeMaker needs to know this so that it can figure out 
how much music will fit on the tape. Note that most cassettes hold more than they claim. For 
example, a 90 minute cassette usually has 92 minutes or more of tape. You can enter any 
number of minutes and seconds here.



Specifies the amount of times TapeMaker should allow between songs. You can choose a 
number between -9 and 9 by clicking the up or down buttons.

The negative numbers are most useful. When TapeMaker reads song times from a CD, it reads 
the amount of space reserved on the CD for the song. However, the song may be preceded and
followed by a few seconds of silence. Since you will not typically record that silence on your 
tape, you may want to tell TapeMaker to subtract a few seconds from each song's time. You do 
this by entering a negative value in the counter.

On the other hand, if you are just copying a CD onto tape, some CDs have a few extra seconds 
between tracks (they show up as negative times on your CD player). In this case, you might 
want to specify 2 or 3 seconds between songs.



You may type any text you want, such as a title for the cassette, into the edge flaps. You can 
change the font and whether the text is left justified, right justified, or centered, by positioning 
the mouse over the flap and clicking the right mouse button. A pop-up menu will appear with the 
font and justification items.



Side A and Side B are displayed with all the songs that fit on them. You can change the font by 
positioning the mouse over the flap and clicking the right mouse button. A pop-up menu will 
appear with the font item.

You can rearrange songs by dragging and dropping them. You can remove a song from the 
cassette insert by selecting it and bringing up the pop-up window as above.



The Excess Songs area display all the songs that couldn't fit on the cassette. You can move 
songs between the Excess Songs and Side A or Side B by dragging and dropping them. You 
can remove a song from the cassette insert by selecting it, positioning the mouse over it and 
clicking the right mouse button. A pop-up menu will appear with the option to remove the 
highlighted song..



Displays the amount of music on sides A and B.



Printing the Song List
You might want a list of the songs on the cassette insert, along with their albums and 
playing times, to guide you in making the tape. You can print this list by selecting the 
Insert | Print Song List... menu item.



Removes all the songs from the cassette insert.



Displays the standard Windows Printer Setup dialog.



Closes the window.



To remove a song from the cassette insert, highlight it, then click the right mouse button 
over it. A pop-up menu will appear offering you the Remove Highlighted Song item. Select 
it and the song will be removed.



Displays the standard Windows File Open dialog so that you can choose a bitmap (*.BMP) file 
to use as a background picture.



Lets you choose to have no background picture (by choosing [None]) or the built-in background 
picture, a gray picture of musical notes.



Shows the picture you have selected as it will appear on the cassette insert, tiled, stretched, or 
centered.



Tile: Repeats the picture as many times as necessary to fill the cassette insert's 
background.

Center: Magnifies the picture by an integral amount (e.g. 2x or 3x, but not 2.5x) as much 
as it can while still having it fit in the cassette insert, then centers it.

Stretch: Stretches the picture in both the horizontal and vertical directions (which may end
up distorting it) so that it fills the cassette insert.



Closes the dialog without saving any changes you made.



Skip backward 10 seconds.



Close the CD Player window. If a CD is playing, it continues to play.



Play the CD.



Pause the CD.



Stop playing the CD.



Skip forward to the next track on the CD.



Skip back to the previous track on the CD.



Open the CD drawer.



Shows a variety of information about the CD:

When the CD is not playing, it displays the number of tracks and total playing time.

When the CD is playing or paused, it shows the current track and time.

When the CD drawer is open, it displays Open or Not Ready.



Distributing TapeMaker
TapeMaker for Windows is distributed as shareware.    This means you may make as many 
copies of the program and the on-line instructions as you like.    You may give them to friends, 
put them on computer bulletin board systems, or distribute them in any other electronic medium.
You may not charge for copies of these files, other than for the connect and download time in 
the case of a computer bulletin board, or a nominal copying fee not to exceed $6 in the case 
that you are distributing them on a floppy disk. You may include TapeMaker on shareware CD-
ROM collections regardless of the collection's cost.

The ZIP file you received should be a copy of the ZIP file I created. When you un-zip it, you 
should see verification information from me (i.e. my name should appear after the files are un-
zipped).    If you don't, the files might have been tampered with or infected with a virus.

If you upload TapeMaker to a BBS (and I hope you will!) please upload the original ZIP file.    Do 
not upload a ZIP file that you created, since my authentication information will not be in it.



Opening a Database

Select File | Open from the main window's menu or click the  button on the main window's 
toolbar. If you already have a database open, and you have made changes to the database, 
TapeMaker will ask if you are sure you want to lose your changes. TapeMaker uses files that 
end with a .MUS extension.



Merging Databases
Loads a TapeMaker database and combines it with the one currently in memory.



Saves the changes you have made to your database.



Saves your database under a new file name.



Display the help contents.



Exits TapeMaker.



Exporting to dBase
You can save your data to a file in dBase III format. From there, it can be read into just about 
any database program or spreadsheet program. This allows you to work with your data in ways 
that TapeMaker might not support.

Simply choose File | Export... from the main window's menu and chose a file name for the dBase
format file.

The dBase file will consist of one table with each record having information for one song. The 
record will include the song title, its artist, playing time, track number, and all the information for 
the album it's on (a unique album number, the album title, media, and all your user defined 
fields).



Technical Support
You can get free technical support for TapeMaker by sending e-mail to 
71621.3073@compuserve.com or sending printed mail to:

      Robert E. Alexander
      6 Robinson Drive
      Bedford, MA 01730
      United States of America

Adventurous customers may use directory assistance to find my phone number. I am not 
including it here because it is not my preferred means of support. However, if you need to call, 
you will find me cheerful and helpful. Please keep in mind that I am in the eastern time zone of 
the U.S., I sleep at night, and I am neither cheerful nor helpful when woken up. If you are not a 
registered customer and you need to have me call you back (e.g. you leave a message on my 
answering machine) expect a collect call.



Getting the Latest Version
You can get the latest version of TapeMaker from the World Wide Web at 
http://ourworld.compuserve.com/homepages/Robert_E_Alexander






